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欢迎使用 WinCC flexible“入门指南 - 首次使用者”  

本手册将以果汁搅拌系统为例来说明：使用 WinCC flexible 为 HMI 设备创建用户界面是
何等轻松。 

果汁搅拌系统生产橙子味、苹果味和热带水果味的果汁、蜜露和饮料。 所需配料可从四
个供应罐中获取。 

配料在搅拌槽中混合，然后进行注入。 

果汁搅拌系统操作员可以执行以下任务： 
● 控制供应罐中的填充量 
● 监控供应线阀的状态 
● 输入并传送混合比例 

为了让操作员可以执行这些任务，HMI 设备的用户界面必须“已组态”。 用于完成这些操作
的组态步骤在《入门指南 - 首次使用者》手册中说明： 

● 创建项目 (页 6) 

● 组态画面 (页 20) 

● 组态信息 (页 30) 

● 组态配方 (页 42) 

● 组态画面切换 (页 52) 

● 项目完成 (页 64) 

● 传输和使用项目 (页 72)（可选） 
 

“组态”与 HMI 设备用户界面的创建和组态相关。 

要求 

可使用随附的 WinCC flexible DVD 中“CD_1”文件夹所包含的程序来自行执行这些组态步
骤。 此外，还需要在组态计算机上安装 WinCC flexible“压缩版”、“标准版”或“高级版”。  

下列组件将用于本《入门指南 - 首次使用者》手册中的实例： 

 

进行上述组态步骤只需用到组态计算机。 
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2.1 WinCC flexible 中的项目 
项目汇集了已组态用户界面的所有信息。 项目构成组态的基础。   

在项目中创建并组态操作及监控果汁搅拌系统所必需的所有对象，例如： 

● 画面，用来描述并操作果汁搅拌系统。 

● 变量，用来在 HMI 设备和果汁搅拌系统之间传送数据。 

● 报警，用来指示 HMI 设备上果汁搅拌系统的操作状态。 

2.2 创建项目 

项目向导   

1. 启动 WinCC flexible。 

2

43

1

 

WinCC flexible 项目向导打开。 当创建项目时，项目向导通过指导用户逐步地完成组

态设置来提供支持。 项目向导具有各种常需组态的情况。 通过选择所提供的方案完

成项目的组态设置。  
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2. 创建新项目。 

 

3. 要操作果汁搅拌系统，只需要一台 HMI 设备和一个 控制单元。 选择方案“小型机
器”(Small machine)，然后单击“下一步”(Next) 接受该选择。 

1

2
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4. 组态该方案。 

– 选择 HMI 设备并输入 HMI 设备的版本。 设备类型和版本的信息可在 HMI 设备的

背面看到。 

– 接受默认设置“IF1 B”作为“入门指南”项目的连接方式。 

– 使用预定义的“SIMATIC S7 300/400”作为 PLC。 

– 单击“下一步”(Next)，接受设置。 

1

5

4

3

2

 

5. 单击“下一步”(Next) 以应用下一页面“画面模板”(Screen template) 上提供的标准设

置。 

6. 单击“下一步”(Next) 以应用下一页面“画面导航”(Screen navigation) 上提供的标准设

置。 

7. 单击“下一步”(Next) 以应用下一页面“系统画面”(System screens) 上提供的标准设置。 
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8. 单击“下一步”(Next) 以应用下一页面“库”(Libraries) 上提供的标准设置。 

9. 现在请输入有关项目的信息并单击“完成”(Finish) 创建项目。 

4

2
3

1

 

 

 

本“入门指南”以 HMI 设备“KTP600 Basic”为例介绍了组态的原理。 可以将此组态过程应

用于其它 HMI 设备。 对于特定的 HMI 设备，组态序列中的某些步骤可能不相同。 有关

其它信息，请参考 HMI 设备手册和 WinCC flexible 在线帮助。 
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2.3 新建项目 

简介 

已使用项目向导创建了项目。 

并且将介绍 WinCC flexible 的软件界面。  

WinCC flexible 界面 

项目向导根据指定的信息创建新项目并在 WinCC flexible 中打开它。  

 

在左侧可以看到项目视图及其树形结构。 在此窗口中，用户可以访问项目属性以及 HMI 
设备的设备设置。 树形结构包括项目的所有元素。 可从该窗口中打开所有元素，例如可

组态的对象和可用的编辑器。 可用元素的数量取决于 HMI 设备提供的功能范围。 

HMI 设备显示在中央工作区。 在工作区中编辑项目的所有可组态对象。 WinCC flexible 
的所有窗口都排列在工作区周围。 可以调整除工作区外的所有窗口的大小，或者移动、

固定或隐藏这些窗口。 可使用“视图”(View) 菜单显示隐藏的窗口。 

属性视图用于编辑对象属性，例如画面对象的大小或颜色。 可组态的属性可能因不同的

对象而各不相同。 属性视图仅在特定编辑器中可用。 
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右侧的工具箱包括组态所需的对象、图形以及其它元素。 该窗口划分为以下几大区域：  

● “简单对象”包括预组态的对象，例如 I/O 域、按钮、图形和文本域。 

● “高级对象”包括具有扩展功能的对象，例如报警窗口。 

● 图形包括一组用于创建画面和对象的图像。 

● 库区域允许访问用户自己创建的对象以及外部对象，例如用户自己收集的来自其它项

目的图形或者对象。 

新建项目 

项目向导已自动创建了一些对象，可在项目视图中组态这些对象： 

● 画面 

● 连接 

画面 

在项目树中，“模板”(Template) 画面处于“画面”(Screens) 下供用户选择。 

HMI 设备的“起始画面”在位于树形结构右侧的工作区中自动打开。 在 HMI 设备的显示区

域可看到两个重叠的报警窗口。 报警窗口的灰色阴影指示该报警窗口已被插入“模
板”(Template) 画面中。 稍后运行果汁搅拌系统中的 HMI 设备时需要“错误报警窗口”和“系
统报警窗口”。  

 

错误报警窗口显示工厂中未决的故障。 

系统报警窗口显示了为工厂中的运行状态组态的报警。 

报警指示灯提示用户注意未决报警或要求确认的报警。 
总的报警数量显示在报警指示灯的“小心”符号下。 
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连接 

借助项目向导中组态的方案，用户已定义好 HMI 设备和 PLC 之间的“连接”： 

 

自定义模板 

插入到“模板”中的对象应该是那些出现在所有画面中的对象，例如之前提到的报警窗口。

一个画面包含 32 层。 顶层“层 0”是画面的标准视图。 要在标准视图中显示的对象（例如

报警窗口）将被添加到顶层之下。 

因为在果汁搅拌机运行过程中报警窗口只在消息出现时才显示，所以在组态期间可以禁止

报警窗口始终显示。 为此，取消激活插入报警窗口的层。  

 

在“选项 > 设置”(Options > Settings) 下，可以隐藏所有与层无关的模板对象。  
组态期间这些对象将不再显示在画面中。 模板中所包括的所有对象都将记录到项目文档

中。 
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1. 双击打开“模板”(Template) 画面： 

 

2. 最小化该窗口以便能够看到下面的报警指示灯： 
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3. 隐藏使用了报警窗口的层 (1, 2)，并关闭模板 (3)。 

1

2

3

 

设置工作台区域 

WinCC flexible 工作台由单个可以按需排列于工作区域周围的窗口组成。 下列区域描述如

何在项目视图中“停放”对象视图。  

 

“停放”是指将窗口整合到 WinCC flexible 工作台中。  
可以自动隐藏停放的窗框以增加工作空间。 
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1. 不隐藏对象视图(1)，组态该视图以便它不会自动隐藏(2)： 

1

2

 

2. 将对象视图移动到项目视图中，在灰色边框根据项目视图做出调整后，即可停放该边

框： 

 



 创建项目 
 2.3 新建项目 

Basic Panel 入门教程 
入门指南, 04/2009, A5E02529531-01 17  

3. 对象视图包含项目视图中所选区域的内容，例如画面： 
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窗口排列的重设 

将窗口停放到所需的位置需经过一些练习。 因此，窗口的排列可以随时重设为其原来的

设置。 

3

5

4

2

1
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中断组态 

可随时停止组态，并在稍后继续。  

● 如果要中断组态，请保存项目 (1)。 

● 选择合适的存储位置，并使用自己可读懂的名称保存项目 (2, 3)： 

3

1

2

 

下一次 WinCC 启动时，该项目会显示于项目向导中： 

1
2
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3.1 画面的功能 
用户界面由多个相关的画面组成。 通过画面可以操作和监视设备，且这些画面是项目的

主要元素。  

画面显示在 HMI 设备上且由可组态的对象组成： 

● 可操作的对象，例如报警窗口、IO 域或按钮。 

● 用于显示值的对象，例如趋势图和棒图。 

● 用于描述对象或画面的提供信息的对象，例如文本域或图形域。 

可将这些对象从工具箱直接拖放到画面中。 

下图显示了作为项目实例的填充量指示器： 

 

果汁搅拌系统的用户界面由四个画面组成。 操作员通过填充量指示器监视存储罐的填充

量。 

下列章节说明水、浓缩果汁、糖和香料的填充量组态。 填充量应以图形和数字两种形式

显示在 HMI 设备上。  
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3.2 组态填充量显示 

组态填充量显示   

需要使用下列对象来组态填充量显示： 

● 储存填充量的变量 

● 以数字形式显示填充量的输出域 

● 以图形方式显示填充量的棒图 

● 用于设定标签的文本域 

以下步骤将介绍如何组态这些对象。 

创建填充量变量 

1. 创建用来存储水填充量的变量“FillLevel_Water”： 

1

2
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2. 组态变量： 

– 输入名称“FillLevel_Water”。 

– 已输入连接“Connection_1”。 

– 将数据类型设置为整数“Int”，因为填充量使用十进制数表示。 

– 在 PLC 中设置包含当前变量值的存储区。 

请确保“名称”(Name) 和“地址”(Address) 与 S7 控制程序中的相关过程变量相匹配。 
有关过程变量的信息，请查阅 WinCC flexible 在线帮助。 

21
 

 

3. 同理，创建变量“FillLevel_Concentrate”、“FillLevel_Sugar”和“FillLevel_Aroma”： 

 

 

PLC 的过程变量将存储通过测量发送器来确定的罐填充量。 如果将已组态的变量组态

为与相关的过程变量相匹配，则将通过设置的连接比较 PLC 和 HMI 设备中的数据。 
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创建一个新的画面以显示填充量 

1. 创建新的画面： 

 

2. 使用“FillLevels”作为新的名称： 

 

创建用于数字显示填充量的输出域 

1. 在可以显示水填充量的画面中插入 I/O 域： 

1

32
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2. 在属性视图中组态 I/O 域的输出格式： 

1

2

3

 
3. 调整 IO 域的大小： 

1

2

 
 

如果通过拖放操作将变量从对象视图拖到画面中，则会自动创建与该变量相连的输入/输
出域（IO 域）。 

创建用于图形显示填充量的棒图 

1. 在画面中插入棒图： 

1

2
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2. 在属性视图中组态棒图： 

– 输入罐 (1) 的容量，然后选择“FillLevel_Water”变量 (2, 3)。 

2

3

1

 

– 调整大小 (2)，然后将棒图右对齐 (3, 4)： 

1

4
32

 

– 取消激活刻度指示器 

1

2
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创建文本域以设定填充量显示标签 

1. 插入文本域到画面中： 

 

2. 在属性视图中输入代表水的“W”： 

 

3. 以同样的方法创建另一个代表单位“升”的标记为“l”的文本域。 



组态画面  
3.2 组态填充量显示 

 Basic Panel 入门教程 
28 入门指南, 04/2009, A5E02529531-01 

排列文本域、棒图和输出域。 

1. 在显示区域，使用光标键定位两个文本域、棒图和 IO 域： 

 

2. 将已组态对象的文本和显示的大小调整为与该视图相匹配。 

对于 TP1500 Basic，需要为按钮保留一部分画面区域。 
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添加果汁、糖和香料的填充量显示 

1. 用同样的方法创建果汁、糖和香料的填充量显示： 

 

 

使用复制和粘贴操作可快速增加填充量显示的元素。 在创建对象时，通过“复制和粘贴”
操作可节约时间。 请确保，正确的变量与 IO 域互连。 

填充量显示已组态。 当系统运行时，操作员可以读取 HMI 设备上罐的当前填充量。  
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4.1 项目中的报警 
报警可用来指示在果汁搅拌系统中出现或经常出现的事件或操作状态。 例如，清除故障

期间可用报警进行诊断。 

报警区分如下： 

● 离散量报警指示果汁搅拌系统中状态的改变，可以由控制器触发。 例如，指示阀是否

打开或关闭。 

● 模拟量报警指示值已经移动到允许范围的限制值之外。 

模拟量报警将触发，例如当电机的速度降低到指定值以下时。  

通过报警视图，操作员可获得有关设备操作状态的信息。  

4.2 组态离散量报警 

简介 

果汁搅拌系统中的每一个罐都装配有进给阀。 下列章节说明如何组态报警显示，以显示

水、果汁、糖和香料所使用的进给阀的状态(打开或关闭)。 

当操作期间打开或关闭阀时，将触发相应的离散量报警。 

创建变量以存储状态   

阀的状态存储在“Valve_Status”变量中。 在变量中为每一状态都分配了一个位。  

● 水阀： 第 0 位和第 1 位 

● 果汁阀： 第 2 位和第 3 位 

● 糖阀： 第 4 位和第 5 位 

● 香料阀： 第 6 位和第 7 位 
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1. 创建“Valve_Status”变量： 

1

2

 
2. 组态变量： 

21
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创建用于状态显示的报警 

1. 创建新的离散消息： 

2

1

 

2. 在属性视图中创建离散量报警： 

– 输入“阀（水）打开”(1) 并选择报警类别“警告”(2, 3)： 

3

2

1
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– 选择存储阀状态的变量。 

3

21

 

– 选择代表“打开”状态的位号： 

 

当水罐阀打开时，离散量报警“阀(水)打开”将触发。 

3. 用同样的方法组态表示“关闭”状态的离散量报警“阀（水）关闭”。 
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4. 用同样的方法组态用于“果汁”、“糖”和“香料”阀的离散量报警： 

 

 

双击下一空行可添加第二个离散量报警。 将调整第一个离散量报警的设置。 报警编号

和位号将自动增加。 现在请调整文本。 
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4.3 组态模拟量报警 

简介 

果汁搅拌系统的搅拌槽装配有搅拌器，必须对其速度加以监控。 当速度移动到上下限值

以外时，相应的报警应显示在 HMI 设备上。 

创建存储速度的变量 

搅拌器的速度存储在“Mixer_Speed”变量中。  

1. 创建“Mixer_Speed”变量： 

1

2

 

2. 组态变量： 

21

 
3. 在属性视图中，选择“常规”(General) 下的“循环连续”(Cyclic continuous) 模式。 

 

变量的周期更新将增加系统负载。 仅在系统限制范围内使用周期更新，通过“WinCC 信
息系统”>“性能”>“系统限制”(WinCC Information System > Performance > System 
Limitations) 可获取系统限制的信息。 
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创建用于速度监控的报警   

1. 创建新的模拟量报警： 

2

1

 

2. 在属性视图中组态模拟量报警： 

– 输入“搅拌器过速”(1) 作为报警文本并选择报警类别“错误”(2, 3)： 

3

2

1
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– 搅拌器的速度将存储在“Mixer_Speed”变量中。 选择变量“Mixer_Speed”。 

3

21

 

– 输入“800”作为最大有效速度： 

 

– 选择“在上升沿”： 

 

3. 以同样的方法组态“搅拌器欠速”报警。 当速度降到 400 (“下降沿”处) 以下时，应触发

报警。 

 

 

双击空行可将第一个模拟量报警的设置传递给第二个模拟量报警的设置。 只需调整设

置。 报警编号自动增加。 

“Errors”报警类别的报警必须由操作员确认。 
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4.4 组态报警视图 

简介 

错误报警窗口用于通知操作员设备运行期间的异常现象。 在此项目的模板中插入了错误

报警窗口，这样在发生错误时这些窗口可显示在每个画面中。 

报警视图显示所有目前出现的错误报警和警告报警。 

以下步骤将介绍如何组态报警视图。 

创建报警视图   

1. 创建新的画面： 

 

2. 使用“Messages”作为新的名称： 
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3. 将报警视图拖动到显示中： 

2

1

 

4. 在视图中调整报警视图画面的大小。 

使用 TP1500 Basic 时，请为按钮留出一块专门的区域。 
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5. 在属性视图中组态报警视图： 

– 选择显示在报警视图中的报警类别： 

21

 

– 做出必要的选择，以便最后进入的消息显示在第一行，并且显示的报警文本带有时

间： 

1 2

 

当系统运行时，水、果汁、糖和香料罐的状态出现在画面“FillLevels”上。 

水、果汁、糖和香料阀的操作状态会在报警视图中列出来。 

搅拌机的速度偏离通过单独的错误报警窗口中带时间的错误报警显示出来，并记录在报警

视图中。  
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5.1 配方的功能 
配方包含相关生产数据的组合，例如混合比例。 混合比例可以在单个工作步骤中从 HMI 
设备传送到果汁搅拌系统，以便(例如)从橙汁生产转为橙子蜜露生产。 

果汁搅拌系统可以生产“橙子”、“苹果”和“热带水果”味的饮品。 为每一种味道创建一个配

方。 每种味道所需的配料在配方中定义。 

因此每一个配方包含三条配方记录，其中存储着用于“果汁”、“蜜露”和“饮料”的混合比例。 

 

 

配方收集易于使用的参数记录中的生产参数。  
通过配方可以用最简单的方法来将果汁生产转换为其它混合比例或味道的饮品生产。 
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5.2 组态新配方 

简介 

下列章节说明如何创建“Orange”配方连同对果汁、蜜露和饮料的相关混合比例。 

创建“Orange”味的配方   

1. 创建新的配方： 
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2. 输入配方的名称和视图名称： 

21

 

创建用于配料数量的变量 

需要四个变量以便将混合比例传送到果汁搅拌系统。 每个变量都包含一种配料的数量。 

1. 创建具有如下设置的变量“Litre_Water”、“Litre_Concentrate”、“Kilo_Sugar”和
“Gram_Aroma”。 
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创建用于配料的配方元素 

对于每一种配料(本实例中为水、糖和香料)都需要一个配方元素。 

1. 新建一个“Litre_Water”配方元素。 

1

2

 

2. 输入配方元素的名称和视图名称： 

 

3. 将该配方元素与“Litre_Water”变量链接： 

2

1

 

4. 同理，创建配方元素“Litre_Concentrate”、“Kilo_Sugar”和“Gram_Aroma”： 
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输入混合比例 

对于每种饮品：“果汁”、“蜜露”和“饮料”，都需要一个指定的配料数量。 混合比例存储在

配方数据记录中。 

 

 

混合比例也可以在外部程序中输入，例如 MS Excel，然后导入 HMI 设备。 

在 WinCC flexible DVD 的“CD_3\Documents\[Language]Getting Started”文件夹下可以

找到此类文件的实例。 更多信息，请参阅 WinCC flexible 的文档。 

1. 创建称为“Beverage”的新配方数据记录： 

1

2

 

2. 输入名称、视图名称和编号： 

 



组态配方  
5.2 组态新配方 

 Basic Panel 入门教程 
48 入门指南, 04/2009, A5E02529531-01 

3. 输入配料的数量： 

 

4. 用同样的方法，创建“Nectar”和“Juice”配方数据记录： 
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5.3 组态配方视图 

简介   

操作员可以在运行期间在 HMI 设备上更改和管理配方。 这就需要有可提供以下命令的配

方视图： 

● 创建配方数据记录 

● 保存配方数据记录 

● 删除配方数据记录 

● 将配方数据记录传送给果汁搅拌系统 

● 从果汁搅拌系统中读取配方数据记录 

为此，插入配方视图： 

1. 创建新的画面： 

 

2. 使用“Recipes”作为新的名称： 
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3. 将配方视图拖动到显示中： 

 

4. 在属性视图中启用可应用于配方视图中的功能。 

21
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5. 然后定义下列视图设置： 

3
1

2
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6.1 组态选择画面 
在选择画面中，操作者会看到如何切换至操作设备的特定画面上并如何能够返回选择画

面。 操作者通过选择画面的构架和画面切换连接进行控制。 

在我们的示例中，将画面切换分配至操作设备的功能键 <F1> 至 <F4> 上。 利用 <F5> 键
关闭操作设备。 

步骤 

1. 打开“起始画面”： 

 

2. 重命名“起始画面”： 

1

2
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3. 使用“Selection”作为新名称： 

 

4. 删除下列画面中存在的对象： 

– 带有“起始画面”画面名称的文本区 

– 带有“起始画面”文本的按钮 

5. 创建五个包括下列内容的文本区： 

– “F1 = 填充量” 

– “F2 = 报警” 

– “F3 = 配方” 

– “F4 = 选项” 

– “F5 = 关闭” 
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6. 在项目窗口中定义“设备设置”内的起始画面： 

– 启动操作设备之后，始终首先显示起始画面。 因为已调整了由项目向导设定的“起
始画面”，因此，已将“Selection”画面记录为起始画面： 

1
3

4

2
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6.2 使用功能键组态画面切换 

使用功能键组态全局画面切换   

1. 打开模板： 

 
2. 将切换到“FillLevels”分配给功能键 <F1>： 

2

1

3

 

一旦在运行时按下 HMI 设备上的 <F1> 功能键，显示填充量的画面将出现在显示屏

上。 
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3. 在功能键 <F2>、<F3> 和 <F4> 上将改变分配到“Messages”、“Recipes”和
“Selection”。 

 

在“模板”(Template) 中组态的功能键将具有全局效果。 在每个画面中，同一按键可触发

相同的功能。 也可以在各个画面中分别组态按键的功能。 

组态 HMI 设备的取消激活 

已完成的项目将显示 HMI 设备的用户界面。 打开 HMI 设备时将自动启动和显示用户界

面。 

1. 打开“Selection”画面： 
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2. 将“StopRuntime”系统函数分配给 <F5> 按键： 

2

1

4

3

 

3. 使用“项目”(Project) >“保存”(Save) 将项目保存到所选目录中，以使设置生效。 

 

包括 .hmi 扩展名在内的项目名称不能超过 120 个字符的长度。 

包括 .hmi 扩展名在内的路径名称不能超过 218 个字符的长度。 
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6.3 使用按钮组态画面切换 

简介 

TP1500 Basic 没有功能键。 在“模板”(Template) 中组态将触发画面切换的按钮。 这些按

钮显示在所有画面中且具有全局效果。 

使用按钮组态全局画面切换  

1. 打开模板： 

 

2. 在画面中插入按钮。 
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3. 将切换到“FillLevels”画面分配给以下按钮： 

1

2 3

 

4. 键入按钮名称“F1”。 

一旦在运行期间按下 HMI 设备上的“F1”按钮，显示填充量的画面将出现在显示画面

上。 
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5. 组态以下按钮进行画面切换： 
 

标签 画面切换为 

F2 "Messages" 

F3 "Recipes" 

F4 "Selection" 

 

 

在“模板”(Template) 中组态的按钮将具有全局效果。 在每个画面中，同一按钮可触发相

同的功能。 
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组态 HMI 设备的取消激活 

已完成的项目将显示 HMI 设备的用户界面。 打开 HMI 设备时，将在运行系统中自动启动

和显示用户界面。 

1. 打开“Selection”画面： 

 

2. 组态一个按钮并将其命名为“F5”。 

1

2
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3. 为按钮的“按下”事件分配系统函数“StopRuntime”： 

1

2

4

3

 

4. 保存项目以便设置生效。 
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 项目完成 
 7.1 一致性检验和模拟 

Basic Panel 入门教程 
入门指南, 04/2009, A5E02529531-01 65 

7.1 一致性检验和模拟 
组态期间，检查您的输入。 “字节”数据类型的变量可在 0 和 255 之间选取。 尝试输入大

于 255 的数值时，禁止输入。 但是，输入时不检查组态的不完整性，例如未分配变量的 
EA 区。 生成期间，通过一致性检验才发现类似错误，并将其列在输出窗口中。 

如果 WinCCflexible 安装了模拟/运行组件，那么可利用运行模拟器模拟项目。 模拟器更

改组态变量值。 通过模拟表选择变量并更改数值。 因此，即使不连接控制器也可对功能

和组态过程进行逼真检查。 

 

 

没有连接控制器时，只模拟组态范围内的变量。 

模拟器利用连接的控制器更改 S7 程序中相关过程变量值。 配合使用控制器时，模拟组

态。 这样，您可检查是否正确传送了过程及项目变量之间的数值。 
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7.2 运行一致性检查 

简介 

您已经创建了第一个项目： 在结束组态工作之前，可以通过移植一致性检查函数和

WinCC 提供的仿真器来测试和仿真项目。 

检查项目的一致性   

一致性检查可确定丢失的链接、取值范围的偏离和不正确的设置。 

1. 通过再次编译项目可启动一致性检查： 

– 在“项目 > 编译器 > 编译”(Project > Compiler > Compile) 下可找到此功能。 

 

一致性检查的结果出现在输出视图中： 

 

 

 

 

如果在编译期间未出现任何错误或警告，则可仿真该项目。 

如果出现错误，则通过双击输出窗口中的错误条目可以从快捷菜单直接跳到项目中的错

误位置。 
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7.3 运行时仿真 

简介 

仿真功能有助于找到逻辑组态错误，例如不正确的限值。  

下列章节说明如何仿真填充量指示器和用于阀状态的报警。  

创建仿真表格   

1. 启动仿真器： 

 

将显示仿真器和仿真表格。 

2. 在仿真表格中选择“FillLevel_Water”变量，然后输入仿真值： 

1
2

3

 

通过显示的仿真表格控制 WinCC flexible 运行系统仿真器。 在“变量”(Tag) 列中选择

已组态的变量并在表格的各行中依次输入这些变量。 变量的属性显示在带有黄色阴影

的“数据类型”(Data Type) 和“当前值”(Current val.) 列中。 白色列中的条目是仿真器设

置并用于控制仿真过程。 
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3. 完成带有变量 "FillLevel_Concentrate"、"FillLevel_Sugar"、"FillLevel_Aroma" 和 
"Valve_Status" 的仿真表格： 

 

4. 保存仿真表格 

1

32
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仿真项目 

1. 启动仿真： 

 

如果选中变量的“启动”(Start) 选项，则将启动此变量的仿真。 仿真器根据所选的设置

变更变量值。  

为进行可靠的功能测试，应选择仿真器的设置以便与变量的功能相对应。 其值彼此相

互关联的变量可以一起仿真。 
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2. 切换到“FillLevels”画面并观察填充量的改变情况： 

 

3. 切换到“Messages”画面，然后观察阀状态上的报警如何触发： 
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4. 切换到“Recipes”画面，然后打开任一配方数据记录： 

3

2

1

4

5

 

 

可在仿真器窗口中再现设备的运行。 使用 HMI 设备显示画面中的报警窗口的相应功能

确认未决的错误报警。 
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8.1 概述 
已在项目中创建了 HMI 设备的图形用户界面。 已创建用于从 PLC 读出过程值或将过程

值传送到 PLC 的变量。  

必须满足以下要求才能在 HMI 设备上使用该项目： 

1. HMI 设备已连接到合适的电源。 

2. 组态 PC 装配有合适的接口适配器并与 HMI 设备相连接。 

如果满足上述条件，则将执行以下步骤： 

● 检查连接参数 

● 传送项目到 HMI 设备 

● 在 HMI 设备上运行项目 

即使该项目是为其它 HMI 设备而不是 KTP600 Basic 创建的，这些要求和步骤仍适用。 

如果可以访问 SIMATIC S7-300/400 PLC，则可以将准备好的 S7 程序上传到 PLC，以便

在 HMI 设备上结合使用 PLC 真实地仿真项目。 
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8.2 前提条件 

供电 

为了使用操作设备，需要恰当的电源。 

您的操作设备是根据 SIMATIC 控制器电源 (Power supply) 供电设计而成的。 电源必须满

足下列前提条件： 

● 仅使用适用于 DC-24-V 供电的电源引入装置，该装置带有安全的电隔离功能，且符合 
IEC 60364-4-41 和 HD 384.04.41（VDE 0100，第 410 部分）规定，例如符合 PELV 
标准。 

● 供电电压仅允许位于规定的操作设备电压范围内。 耗用电流不得超出操作设备的规定

值。 否则，不排除有操作设备功能失灵的情况。 在操作说明内或您操作设备背面的

铭牌上查看说明。 

● 在非绝缘结构中： 24-V 电源输出端接口“GND”连接统一基准电位的电位均衡。 期
间，选择尽可能集中的连接点。 

● 只能由合格的人员根据操作设备的操作说明连接并开动操作设备。 

与组态 PC 连接 

您的 PC 必须具有恰当的接口，才能连接组态 PC 和操作设备。 

连接时，需要使用安装在 PC 内的 MPI 接口卡或外部适配器。 如果 MPI 接口卡已安装在

您的 PC 内，则可通过附属 MPI 电缆连接您的操作设备。 

在 https://mall.automation.siemens.com 下获取下列外部适配器： 

● 串行 USB/PPI 电缆，订货号 6ES7 901-3DB30-0XA0 

● 串行 PC/PPI 电缆，订货号： 6ES7 901-3CB30-0XA0 

● MPI“PC 适配器 USB”，订货号： 6ES7972-0CB20-0XA0 
附属电源适配器，订货号 6ES7972-0CA00-0XA0 

https://mall.automation.siemens.com/CN/guest/
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在该“入门教程”中使用了“PC 适配器 USB”。 

 

通过自带的电源为“PC 适配器 USB”供电，并通过随附的 USB 电缆连接组态 PC。 如果

附属软件已安装在 PC 上，则适配器可自动识别并提供连接控制器和操作设备的灵活 MPI 
接口。  

项目中使用了“PROFIBUS”MPI/DP 接口。 该接口已在您项目的“连接”下设置为了“连接

_1”。 

更多传输信息请查看互联网中 Basic Panel 
http://support.automation.siemens.com/CN/view/zh/31032678 的操作说明和 WinCC 
flexible 在线帮助。 

 

通过以太网使 Basic Panel 的 PN 设备与组态 PC 相连。 

通过 MPI 可保存和恢复数据、传输项目或更新操作系统。 通过 MPI 无法更新带有“复
位到出厂设置”的操作系统。 

http://support.automation.siemens.com/CN/view/zh/31032678
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8.3 检查连接参数 
连接参数可定义 HMI 设备和组态 PC 之间的数据连接。 只有在以下设置均正确时才能成
功传送：  

● 在项目的“连接”(Connections) 下组态的设置与 HMI 设备的传送设置相匹配。 

● USB/PPI 适配器组态为 HMI 设备的有源 MPI 接口。 这些设置与项目中的设置相匹
配。 

检查项目中的连接参数 

1. 打开“连接”(Connections) 编辑器： 

 
2. 检查使用项目向导创建项目时所做的设置。 

必须设置以下地址： 

– HMI 设备： 1 

– PLC： 2 

PLC 和 HMI 设备通过 MPI 网络互相通信。 
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检查适配器的连接参数 

在组态 PC 的 Windows 控制面板中可以找到适配器的参数设置。 

1. 打开 Windows 控制面板 

2. 通过“设置 PG/PC 接口”(Set PG/PC Interface) 打开 PG/PC 接口的设置。 

3. 查看是否已将“PC 适配器 USB”设置为已组态 MPI 网络的接口。 

4. 通过检查来确保“属性/MPI”(Properties/MPI) 下适配器的设置与已组态的设置相匹配。 

如果适配器的设置与项目中的设置不匹配，则适配器无法传送该项目。  

检查 HMI 设备上的连接参数 

HMI 设备的传送设置必须与项目中的设置相匹配，以便 HMI 设备接收项目数据。 

1. 接通 HMI 设备的电源。 

HMI 设备启动。显示装载程序。 

2. 通过按装载程序的“控制面板”(Control Panel) 按钮打开控制面板。 

3. 按下“传送”(Transfer) 按钮，以打开“传送设置”(Transfer Settings) 对话框。 

4. 激活“传送”(Transfer) 窗口中的 MPI/PROFIBUS 通道，并通过“高级”(Advanced) 按钮

打开高级设置。 请确保“高级”(Advanced) 窗口中的设置与项目中的设置相匹配。 

8.4 传送项目到 HMI 设备 
检查连接参数后，将项目数据传送到 HMI 设备。 

准备工作 

必须将 HMI 设备设置为传送模式，以便可以接收已传送的数据。 

1. 接通 HMI 设备的电源。 

HMI 设备启动。显示装载程序。 

2. 选择装载程序中的条目“传送”(Transfer) 将 HMI 设备切换为传送模式，以进行数据传

输。 

HMI 设备将切换到传送模式。对话框窗口中将显示消息“连接至主机...”。 
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传送 

将项目数据传送到 HMI 设备： 

1. 在 WinCC flexible 中启动传送 (1)。 

也可以通过“项目 > 传送 > 传送设置”(Project > Transfer > Transfer settings) 菜单启动
传送。 

2. 检查传送的显示设置 (2, 3) 并启动至 HMI 设备的传送 (4)： 

4

2

1

3

 

3. 跟踪 WinCC flexible 中和 HMI 设备上显示的传送步骤。 

 

项目传送到 HMI 设备后，自动执行一致性检查。 如果项目中仍然存在错误，则传送将
中断并提示相应的错误消息。 
如果要传送的项目大于设备内存，则不会完全传送该项目且会针对该情况显示一条消
息。 

在 HMI 设备上使用项目 

成功传送后 HMI 将自动重新启动。 等待启动过程完成，随后将显示装载程序。 数秒后 
HMI 设备将启动项目。 

现在可以在 HMI 设备上调用和观察项目的画面，或者检查配方视图的功能。 因为组态的
变量没有发生改变，所以显示画面将为静态显示且不会创建任何消息。  

要以切合实际的方式运行 HMI 设备，设备必须连接到实际的 S7 控制器。  
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8.5 使用带有 S7 控制器的项目 
您已将项目成功传递至操作设备并进行了测试。 

在以下段落中介绍了操作设备和控制器的相互关系。 

为了在 S7 控制器上使用经过组态的操作设备，必须满足下列前提条件： 

● 经过组态的操作设备连接准备就绪的绝缘 S7 300/400 控制器。 

● 通过接口适配器将与项目匹配的 S7 程序传输到您的控制器上。 

● S7 程序的过程变量值根据项目自动更改。 

S7 控制器的功能 

在实践中，控制器处理通过控制值调节机器或设备内过程的程序。 控制值符合独立设备

组件的状态，并利用程序数据块范围内定义的变量来测定控制值。 如果数据块内包含的

变量与项目中设定的功能及定址变量一致，则校准过程及项目变量之间的测定值。 通过

操作设备上的输入更改关联变量值，并由此启动控制器反应。 将过程值传输至组态的变

量中并在项目中显示。 

您需要安装就绪的 S7 控制器才能操作位于操作设备的项目。 S7 控制器必须已处于绝缘

状态，即控制器必须满足下列前提条件： 

● 控制器和实际设备或设备组件之间禁止存在连接。 

● 控制器不得位于传导危险电压的部件范围内。 

成型导轨上由带有相应电源的 SIMATIC S7-300/400-CPU 组成的实验室构造足以满足条

件。 您的操作设备必须连接控制器的电源，并利用 MPI 或 PROFIBUS 总线电缆连接 
CPU。 在 S7 组件操作说明中查看相关信息。 

 

警告  
触摸带电部件有受伤危险！ 
S7-300/400 模块是开放式设备。 电源与电网连接时，导电部件可能导致危险。 
必须由合格人员根据相关操作说明将 S7 模块安装在接地导轨上。 符合相关标准的电源

接头必须采取了防触摸保护。 
只能将 S7 模块安装在外壳、开关柜或电气运行环境中。 设备的使用必须使用钥匙或工

具并只能由经过指导或合格的人员进行操作。 
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S7 程序 

已为您的“入门教程”组态准备了恰当的控制程序。 该程序模拟了连接 S7 控制器内经过组

态的果汁混合设备功能。 通过周期性地更改过程变量中的数值，触发经过组态的报警并

改变填充量的显示。 借此，您可操作位于操作设备的项目。 

控制程序“S7_Mixing”位于您的数据载体上或文件夹“CD_3\Documents\[Sprache]\Getting 
Started”内的 WinCC flexible DVD 上。  

为了将控制程序传输到 S7 控制器内，您需要 STEP 7 或安装好的“PC 适配器 USB”。 在 
S7 在线帮助或 S7 编程手册中查看相关信息。 

1. 启动组态 PC 上的 STEP 7 并加载控制程序“S7_Mixing”。 

2. 将控制程序传输至 S7 控制器内。 

警告  
 

设备组件意外移动或意外功能会造成危险！ 
S7 程序的“入门教程”中不包括任何安全功能。 实际设备或机器的控制器的应用中，

功能可意外启动，并对周围的人员造成伤害。 
不要将 S7 程序“入门教程”传输到实际设备或机器的控制器上。 使用期间，用于“入门

教程”的控制器决不能连接正常运行的设备及其部件。 S7 程序“入门教程”仅仅在绝缘

安装的 SIMATIC S7 控制器上用于辅导。 

使用项目 

1. 接通 S7-CPU 和操作设备的电源，并等待启动过程结束。 

2. S7 程序和您的项目成功传输后，您可操作位于操作设备的组态、观测填充量变化并跟

踪报警窗口内的状态信息。 

结果 

● 随着项目传输到操作设备，您已成功处理了“入门级的入门教程”任务并创建了可运行

的项目。 

● 通过连接操作设备和控制器，您已了解了项目实际应用的基本特点。 现在，您可利用

操作设备和控制器来掌握模拟的所有步骤。 
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